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Introduction

|l ntroducti on

Wel come t o TheBr &idigitl memory and nodirits iintanapping
software. I ntelligence comes fr omthatls,e mi ndé6
to leap from Thought to Thought, building webs of greater and greater complexity,

until new ideas are built. Associations are our inspirations. TheBrain allows you to

organize your information in the same way, without limiting you to a pre-

determined file structure. In fact, with your digital Brain there are no limits. You

can create a small project-focused Brain or grow your Brain to hundreds of

thousands of Thoughts!

Now you don't have to force any idea or project into a single folder. TheBrain

organizes information as Thoughts. Unlike folder directories and search lists, a
AiThoughto in your Brain c aantextsaMoreoveanany conne
TheBrain displays your Thoughts by concept or project, linked according to how

you think. Now you can get the big picture and discover information that might

otherwise be overlooked.

Thoughts contain relevant notes, web pages, and files. Brains can be synced for
easy access from your desktop to TheBrain Cloud or your mobile devices.

'> File Edit Thought View Options Online Window Help - =} >f
Jane's Brain | Jane's Brain { ) Philosophy | Plato ) Product Research | Product Research @ "e' 7: l
AR A| A e o °
£ Personal Life Goals 32 Hobbies Jane's Brain

.Notes. +
Notes to self

O Meetthenew-reighber

Smile at the mirror

’[‘:}h.JJajn? e's Bj rain] Smile at strangers!

L)
o Go.als . HNTy \‘Vcrk
o I'm Most.lngerested In... od Per'sollal Life
o My Latest.Prgoccupat\’ons o“ What I'm Tthk'ing About Now
4
»
4 p sHobbies < Personal Life [jjJane’s Brain :__;

Figure 1. TheBrain Interface

Thoughts are Information

TheBrain Thoughts can represent just about any type of information, including
concepts, people, documents, spreadsheets, images, videos, shortcuts, and web
pages. By letting you create links and associations between Thoughts, TheBrain
expands to become a visual interface that reflects the way you think.
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Introduction

Using simple click-and-dragt ec hni que s, yoeat®dndnahgate abl e t o
through networks of Thoughts in a conceptual space unique to your work habits.

When you begin using TheBrain, you will find that your computer becomes easier

to used faster, more enjoyable, and less frustratingd helping you use your time

more efficiently.

T h e Br aDymafdis Graphical Interface

TheBrain lets you create a simple, dynamic graphical map in which to input and

navigate all your information. Your Brain starts with a single Thought, to which

several other Thoughts can be visually linked. These Thoughts have their own

links to other Thoughts and, possibly, to each other. TheBr ai nés f |l exi bl e s
allows any Thought to be linked to any other Thought, so you are never more

than a few steps away from the information you are seeking. | t 8s si mpl e t o n
connections between Thoughts so that they reflect the connections you make in

your mind.

Cross Platform Accessibility

Brain data is accessible from virtually any device with rich full-featured clients on
Windows and macOS plus mobile clients for iOS and Android. Additionally, you
can access your Brain via a web browser by logging in at www.thebrain.com.
TheBrainbs sync s er v urdaa bkckee ppsandasynthronized over

the cloud for seamless access.

This user guide is focused on the Windows and macOS software. Please visit
www.thebrain.com for information about the mobile clients.

About this Guide

The following icons are used throughout this guide to flag categories of
information:

) This icon is used to identify notes.

’ This icon is used to flag tips and suggestions.

TheBrain is offered in two editionsd Free and Pro. Icons are used throughout the
guide to flag features that are specific to the Pro edition. Features that are
available in both editions are not designated with a special icon.

IP[}’@ This icon is used to indicate that the feature is available in the Pro edition only.

TheBrain 11 User Guide
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Because TheBrain works on Windows and macOS. OS-specific features are
flagged with icons throughout the guide. Features that are available for both
Operating Systems are not designated with a special icon.

#_  This icon is used to indicate that the information applies only to computers
' running macOS.

gl Thisicon is used to indicate that the information applies only to computers
M running Windows.

In addition:

Labels Names of buttons, menus, commands, keys, and icons appear in this font
throughout the guide in order to stand out.

Note to macOS Users

click of your primary mouse button. However, there are several context-
sensitive shortcuts available in context menus which appear when right-
clicking. On a Macintosh, many systems do not have a right mouse button. For
trackpad users, click or tap with two fingers. Alternatively, hold down the
Control key while you click. Note that many mice can be set up to interpret
clicks on each side of the main button differently so that Control-clicking is not
necessary. To enable this, alter the Mouse settings in the System Preferences
area of your Mac. Select ASecondary

'l Right-clicking: Most features in TheBrain can be accessed with just a single

Ctrl key: Some features are accessed by clicking while holding down the Ctrl
key on Windows. For macOS, use the Command key.

Here is a list of working definitions for the basic terms used throughout TheBrain.

Brain A collection of associated Thoughts, each of which can have
content. You can create multiple Brains.

Thought The topics that you link together in your Brain are called
Thoughts and are the basic unit of a Brain. A Thought can
represent anything you want it to. It can include an icon, notes,
and one or more attachments (such as files and web sites) or it
can have no content at all and simply act as a subject heading
or organizer. Minimally, a Thought has a hame.

Plex The visible, graphical portion of your Brain that displays your
Thoughts.

TheBrain 11 User Guide 3
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> file Edit Thought View Options On
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The portion of the Brain window that displays content that can
be associated with the active Thought or link. Types of content
include Notes, attachments (such as worksheets,

presentations, documents, videos, and images), links, URLSs,
and events.

Clicking any Thought or link in the Plex displays its associated content in the
Content Area.

line  Window  Help

Jane's Brain | Jane's Brain
AR A A @

4 Personal Life Goals :tHobbies

e
o Goals
it ’ ]
I'm Most Interested In...

o@ My Latest‘Prgoccupation

i) Jane's Brain
=

=0

Jane's Brain
Notes 4

(&)

Notes to self

Meet the new neighbor
[0 Smile at the mirror
Y O Smile at strangers!
*.aMy \iVork
{ ]
od Persorlal Life

s o© What I'm Tthk.ing About Now

4
>
§/ane’s Brain ;

Active
Thought

Figure 2. TheBrain Plex and Content Area

The active Thought appears in the center of the Plex and is
the current focus. Any items attached to the Thought, like
notes, files, links, and events appear in the Content Area.

- s D
AThought—" *=BMY Work
_CJ)ircIe and
Same Thought barder

N
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n—
*{ g My \‘Vork]’

_t=aMy \Afprk :
=

Figure 3. The Different Ways a Thought Can Appear

Same Thought with
mouseover, but not active
(border, but no circle)
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As shown below, when you click a Thought it moves to the center of the Plex and

it becomes the active Thought.

o4 Per.sorlal Life Goals &% Hobbies

y .
o Goals
- L ]
£ I'm Most Interested In...
¢ © )
o® My Latest Prgoccupatlons

{7ane’ Brain)

%

) 2 Personal Life
o% What I'm Thlnk.ing ABout Now

A/‘*\ Clicking a
Thought ...

4 Personal Life Goals % Hobbies
ol',ﬂarié‘s}Brain B
= : o .Go.als
- of I'm Msst{!merest...
o@ My La;esg Preocc...
4 > Go... ®Com | ® 'My \‘Vork
- m———— o What f'm Thinkin...
... activates : . .
. . . »“B%arpily a o= My Passion
it, moving it ] g ~'r09d % My.m
to the center o[t Health.arld Fitness o8 Perso.naI.Finance
of the Plex o }-Tob.bies ;A'I'ra.vel
oA Horr:e l:rojects
4
4 P Go.. @Company Goals .gMyWork 4 Travel [Jane's Brain 2 Personal Life
Figure 4. Activating a Thought
Thought A Thoughtissaidtobe a f@Tfheughg ® dAchil d
Relationships Asi bl ing Thought, o or Ajump
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someoneds chil dsibl and, samedose
peer, advisor, or colleague. So, who are you? The answer to
that question is relatived it depends on the circumstances

and what hat youdre wearing
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4 oy

You may be ...

a child of

a parent J
\~—a sibling

a colleague

a parent
of a child

L

Figure 5. Relationships are Relative to You

The same applies to Thoughts. The relationships between
Thoughts are displayed automatically, based on which Thought
is active at the moment.

Whether a Thought is a parent, child, or sibling depends on
. its current relationship to the active Thought.

A jump Thought

\»
Budgete
uogeg0

The active Thought

0.& Horne Pro;ects

0) File Edit Thought View Options Online Window Help = o X
/ ==iJane's Brain | Hobbies \ @ E:.' j)‘
CARS A A+ | % |©
£ Personal Life Goals st Hobbies A p arent Th ou g ht

e Food
__o% l!ne.nds «
7 Health and Fitness

.

B MyPassmn S|b||ng
o KAy Pet
, Thoughts
Sy o8 Personal Finance

ob4 Art and Culture
Gardenlng

o IllMusm

= c\gports
) JTechnoIogy
o /What I'm Readmg Now

o Snorkellng and Diving

Child Thoughts

§3Jane's Brain 4 Personal Life &

¢ Hobbies

4

Figure 6. Thought Relationships are Relative to the Active Thought
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Child Thoughts are subtopics of the active Thought. They
appear in the fchild zone,0below the active Thought. In the
picture above, t he ac tsewerechild h
Thoughts.

Parent Thoughts represent super ordinate topics of the active
Thought. They appear in the parent zone, above the active
Thought.

Sibling Thoughts share a parent with the active Thought.
They appear in the sibling zone, to the right of the active
Thought.1 n t he pi cRamiel ya,bdo viek o did
Fitness, 0 AHome Prd@jMgctPe,tq o
APersonalarFe nainkcleibngs of AHo
are all chil difeed of HAPersona

Jump Thoughts are related to the active Thought but are
neither child nor parent topics. They appear in the jump zone
to the left of the active Thought. Jump Thoughts have an
fiequal relaionghip tith the Thought to which they are
related. For example,asshown above, HAHobb]
vari ous ArnerdCultersofifGar deni ng, 0
ASnor kel ing and TEohnglogy,gd, 0a MdS pi
I 6 m Re ad ilinkeg ad\thild/Thoughts since they are
types of hobbies. i B u d g e t sdthe aniofiné af resources
available to spend on the various hobbies and so it is closely
related, but it is not a hobby itself. Therefore, it makes a
perfect jump Thought' related, but not part of the main
Thought grouping.

Thoughtsinthe Plexhave three circular
which is used to link a specific type of relation: The parent
gate is above a Thought, the child gate is below it, and the
jump gate is to the left or right of it. A gate is hollow when
there are no links attached to it and solid when one or more
links are attached. Solid gates in a contrasting color have

links to Thoughts that are not currently showing in the Plex.
The color of gates is based on the current color scheme.
When you point at a gate, a highlighting circle appears

around it.

A link is the line that connects two Thoughts. When used as a
ver b, t dedctofcanketting Thoughts to establish
close relationships. Links can also show direction to help you
visualize relationships.
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Parent gate

ot My Web,Service
Jump gate ‘
\ olIT Re.sogrces
TraveICAgOent Coe @%ﬁng oTecf:anlogy
. OWeb.CI.ients
nCompany?’re(;entations <~Online‘Mgetings
oData Coljgction i o Re;eagch
oGrspi;ics Child gate oT;Ith
Figure 7. Thought Gates
Installing TheBrain and Creating an Account
The first time you download and install TheBrain, y ou o1l | be prompted
create an account i f yThalogdnovindowvpravidesthe dy have

ability to create a new account or log in to an existing account.

&) X

T H&E
® L SRAIN

| |

Forgot Password

Create Account

Figure 8. TheBrain Log-in Window

Herearethef i el ds to complete if youdre creating
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® T HE&E
®
BRAIN
Your first name

' /Your last name

L Email address to
&4 be associated with

Ausefmame [ this account
you create
(no spaces —V A password
and at least 2 4 You create
characters)

v—w Confirmation of
= your password

Newsletter [ | Interested in TeamBrain

| Create Account |

Login

TheBrain Cloud (https://api.thebrain.com/)

Figure 9. Creating a New Account

After you click the Create Account button, TheBrain will send an email to the
address you specified.

, Check for a message from no-reply@thebrain.com. Make sure to check your
. spamf ol der i f you dondét receive the m

When you open the message you will see a green Activate Brain Account link.
After you click the link,you 6 | | s e @nfimmingnyour success.

TheBrain 11 User Guide 9
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THE&E
S BRAIN'

Your Brain account is almost ready!

To activate your account, click the button below.

Activate Brain Account
For more resources on getting started with your BraX, visit our online support center.

Enjoy!

THE

BRAINT

TheBrain Team .

Questions? Call us at

el | Activation Successful: LeeSharpe67@gmail.com

Thanks for verifying your email address. Your account has been activated.
Return to TheBrain application to login.

TheBrain Technologies LP, 11522 W Washington Blvd, Los Angeles, CA 90066

Figure 10. Activating a New Account

Now you can return to TheBrain and log in.

TheBrain 11 User Guide 10
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'> File Edit Options Window Help - =] X
2
Brains = &
©+ C |az
*9» Fle Edit Thought View Options Online Window Help a x
Me | Welcome to Thebrain 8 &
GRS A A =0 °

Me Weelcome ta TheBrain

Welcome —

TheBrain helps you work the
letting you connect informati
you can organize, create, an
elements of your digital life.

. —
@& Welcome to TheBrain
—————w———

> Le;m_MoEre *&Use T'he.Brain for

PR Y

Need help getting started? = / e

/

Create a Quick-Start Brain

Upgrading from TheBrain 87

Import a Brain from TheBrain 8

Figure 11. Welcome to TheBrain

ClickiCr e at e -Start Bpainband follow the directions on the screen to enter a
personalized name for this Brain. The Quick-Start Brain is actually a dynamic

resource for |l earning more about wusing your
useful information in it. Click any of the links to see what is displayed.

)

You can always create a new Quick-Start Brain by selecting the Create a
Quick-Start Brain command on TheBrain Help menu.

Opening Older Brains

When youdr e hmooekwiBraigfilea, hotedhlatdBrains created in
TheBrain 7 or 8 have filename extensions of .brain. Brains created in some earlier
versions have a .brn filename extension.

To open a .brn file that you created in a version older than TheBrain 8, first
[ open it using TheBrain 8 and then import the resulting Brain in TheBrain 11, as
described in the steps below.

To open a Brain that you created in TheBrain 8:

1. Open TheBrain.

TheBrain 11 User Guide 11
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2. Click the File menu, then click the Import command.

/ All dialogs can also be navigated via the tab key.

TheBrain 11 User Guide

(® Create a new brain

O Add to "Me" and link to "Welcome to TheBrain"

Brain Archive
Text Outline
Folders
TheBrain 8 XML
TheBrain 8 Brain
MindManager
FreeMind

(brz)

(txt)

(xml)
(brainzip, brain)
(mmap)

(mm)

TheBrain 8 Brain

All of the data from your Brain will be
imported into this version of TheBrain.
Your existing version 8 Brain will not be
changed and will remain available.

Note that any changes you make in here
cannot be migrated backward to version 8.

To import data from earlier versions of
TheBrain, open it using TheBrain 8 first then
import the resulting Brain here.

| Select File... || Cancel

Figure 12. Import Box for Opening an Older Brain

Click the Select File button, navigate to the Brain of your choice, then click
the Open button when the file is selected. You will see a running progress

report.

When TheBrain has finished converting, you wi || s

compl et eo

message as Ispostwuttonb el ow.

a

12

fConve

Cl

ck
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Introduction

& Import

@® Create a new brain
O Add to "Me" and link to "Welcome to TheBrain"

Brain Archive (brz)
Text Outline (txt)
Folders

TheBrain 8 XML (xml)

TheBrain 8 Brain  (brainzip, brain)

MindManager (mmap)

FreeMind (mm)

Source: |asdf.brain

Conversion comp

Click "Import” to

Import | | Cancel

Figure 13. Import Conversion Progress

When TheBrain has finished importing, you will see the following dialog
box. Click the Open button to open the Brain you just imported in a new tab

of TheBrain window.

Import Complete

Do you want to open the imported brain?

Open II Cancel

Figure 14. Open the Imported Brain in a New Tab

13
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Suggestions for Transitioning to Your New Brain

Here are some tips for establishing a happy relationship with your Brain:

v

Begin by taking yourself on the guided tour provided in the next section of
this guide. As you exit t homskilsofargettingy ouél | al
your Brain up and running quickly and easily. You may also want to attend one of
TheBr ai ndlsi fea eseemi nars on getting started’' T
about TheBrain 101, go to http://www.thebrain.com/101.

Avoi d fconv e r-onlyenyi@nnerd allat oie. Makethe
transition on a file-by-file basis so that every piece of information your Brain
contains will be useful.

Build your Brain as you god associating Thoughts as they occur naturally.

Avoid the temptation to move large folders into your Brain. TheBrain can
handle this, but your Brain will be cluttered with Thoughts you may not need.

Remember that your first dlyBrainmoryduwlass ndt need

Brain. Experiment! Create a Brain just for fun, to try out the possibilitiesd give
yourself room to stretch and explore. Your Brain is waiting!

TheBrain 11 User Guide 14
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A Guided Tour of TheBrain

A Gui ded Theeurai of

The best way to build your comfort level with your Brain is to build one yourselfd
with your very own hands. This guided tour will walk you through the basics,
pointing out items of interest alongtheway. Ther eés no need to take

youol | never get | eft behimodtstrategicpaceds e Yy ou bl
your own.

’ During this tour, youoll be asked to
to refer to items and areas as the tour proceeds.Nat ur al | y, whe
your own, youdll use your own ideas
Herearethesi gn posts youodl:l see along the way

Enter hered the startup action for this phase of your guided tour

Point of interestd take out your virtual camera

/ Tipd where you can find more details about this step of your guided tour
Take fived this is a good place to take a break if you want one

Exit hered this marks the end of your guided tour

Letds go!

Part 1. Start Up and Explore the Brain Window

A

Itinerary: Yo u 6 | | ThkeBraim, treate p new Brain, and tour through the
components of the Brain window.

Startup TheBr ai n, unl es s i.¥dusan select EBhaBtayn fronutiren i n g
Start menu or the desktop icon. On macOS, TheBrain app can be found in the
Applications directory.

TheBrain 11 User Guide 15
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0 S Filters \v/

Best match

TheBrain
Desktop app E
' ' TheBrain 9 7

Figure 15. Starting TheBrain

Log in to your Brain account. This enables integration with any subscriptions you
may have.

=

T H&E
® P SRAIN

Username or
Email address

| | ‘/ Your Brain
r%y password

| |

Forgot Password

Create Account

TheBrain Cloud (https://api.thebrain.com/)

Figure 16. Logging In to TheBrain

1. Click the File menu in the menu bar at the top of the window on the
welcome screen (or click the File menu, then click the New Brain

command).

TheBrain 11 User Guide
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A Guided Tour of TheBrain

') File | Edit Options Window Help
/;-’/? New Tab Ctrl+T

B New Window Ctrl+Shift+N
O+

Create Brain.h..

L

Import...

Create a New Brain

Export...
Utilities
Close Tab

Close Window

Exit

Ctrl+W
Alt+F4

Figure 17. Create Brain Command

In the empty field, type: Tour

63 Create Brain

IToun{

|

oK || Cancel H

Figure 18. Create Brain Dialog

3. Press the Enter key or click the OK button to finish creating your new

TheBrain 11 User Guide

Brain. It will appearinanewtabnamedfi Tour . 0

Your

similar to the one below. Note that you can minimize, maximize, or restore

TheBrain window u s i

ng standard

Wi.ndows 0

17
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A Guided Tour of TheBrain

'} File Edit Thought View Options Online Window Help
<+—— Brain tab

Tour | Tour

4« ARRS

The Plex

{fowr]

First Thoughtin I
your Brain

Past Thought List

qa >

©Welcome.. Me Tour

A A+ @ <«—— Brain button bar

4
»
-
=

<«—— Menu bar

- a X
[Search box & ~

= [ o

— > Tour

Name of Active Thought

Notes 4+

AW EB7AMEF|[~

G =

The Content Area

Figure 19. New Brain in the Plex

TheBrain creates your first Thought for you. It has the same name as your Brain

(which you can change later if you wantto). Si nc e
Thought

t h ectivé Thought® t h e

i tos

t he
t hat 6s

currently

4. Take a few minutes to click some of the Brain Themes to see how the

onl vy

Tho

s el

Theme box.

background of the Plex changes. Thenc | i ¢ k
Def auseleai tt .o

t he ThlLagmeBluen a me d

CIXoc lort Ipesckey totclbse the Brain

blank area of the Plex and selecting Brain Theme.

You can always return to the Brain Themes box by right-clicking within any

TheBrain 11 User Guide

18

e

i



A Guided Tour of TheBrain

@ The Brain Toolbar

Adjust the Display

Activate Open the size of the Plex
the Home list of text in the layout
Thought~ Types Plex options
Activate | ; i ; g Sync this
previous [ |~] [ ] [ ]D[ ] [ ]‘_ Brain with
Thought _.BB ﬁ A ‘ AA ‘k ‘ . the server
— 4 A [
Activate the Open the Show 1 fewer Show 1 more
next Thought list of Tags generation generation

of Thoughts of Thoughts

Figure 20. TheBrain Toolbar

1. Point at each one of the buttons in the Brain toolbar so that you see a brief
explanation in the pop-up tool tip.

Note that since your Brain has only a single Thought so far, some of the
toolbar options are currently disabled.

@ TheBrainbs Content Ar ea

-) File Edit Thought View Options Online Window Help

\ aw ()
Tour | Tour '

AR A A a =~ 0

INotes +

M N BT AEF |~

i
(<)
Il

My tour of TheBrain.

-
4 b ©Welcome ... Me Tour o

Figure 21. A Note in the Content Area
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1. Click in the empty white space of Content Area, then type: My tour of
TheBrain. Y o u dustereajited your first Note, which is associated with the
facti ve TMhouught O

Notes are saved automatically and always stay associated with the active
Thought, even when you activate other Thoughts or close your Brain.

.

2. Experiment with any of the buttons in the Notes tab toolbar if you want a
quick peek at some of the functionality.

/ Tip: See the section beginning on page 152 for details about working with the
Content Area.

Part 2: Create New Thoughts

Itinerary: Y o uddelaté a single Thought, multiple Thoughts, a Thought from an

existing file,anda T h o u g ht mddify the refatioashimbetween two
Thoughts.

Your Tour Brain should be on the screen, as you left it in Part 1.

1. The three small circles in the border around the Tour Thought are called
fi g a t The hotéom circle is called the child gate because it provides a
gateway towards creating a child Thought. Drag the mouse from the child
gate down a short distance, then release the mouse button. The Create
Child dialog will open.

/ Tip: If you prefer not to drag the mouse to create a Thought, right-click the Tour
Thought and then click the Create Child command on the context menu.

Child gate

(o)

NZ

|TB Buddieq

Figure 22. Dragging from the Child Gate

The context menu for the active Thought can also be accessed by clicking on
the Menu key on a Windows keyboard.

.
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2. Inthe empty field, type: TB Buddies

This Thought will organize Thodalk¢gpht s abou:
about how they use TheBrain, so you can share experiences.

3. Press the Enter key. A larger circle appears around a new Thought for a
few seconds, highlighting it for easy visibility. Your Tour Thought now has a
chidThought TB8mdaddi(lsshr@ort for ATheBrain Bud:c

@ Creating Multiple Thoughts at Once

You can create more than one Thought at a time by typing a semicolon to
separate each Thought.

1. Create four new child Thoughts for Tour, all at the same time. To begin,
drag Tourb6és child gate dowmutten. bi t, then r

2. Inthe empty field, type: Tips; Reminders; To-Do; New Brain Ideas

| |Tips;Reminders;To-Do;New Brain Ideas

| -

Figure 23. Create Multiple Thoughts at Once

/ Tip: The semicolon (;) between each Thought name tells TheBrain that these are
separate Thoughts. Typing a space after each semi-colon is optional.

3. Press the Enter key.

Note that the new Thoughts are arranged in alphabetical order. To change the
/ order of Thoughts, right click in the background and select Arrange Thoughts
. b y éFrom here, you can arrange thoughts by Name, Type, and Date Modified,
Created or Activated in Latest or Oldest orders. Thought sorting disregards
articles such as A, An and The.
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@ Create a Thought by Dragging and Dropping an Existing File

You can create a Thought by dragging a file from the desktop or from your file
manager (such as File Explorer on Windows or Finder on a Mac). The new
Thought will have the same name as the file (minus its extension) and it will
automatically have the file as an attachment. It will become a child of the active
Thought. Y o uléarnimore about attachments in the next part of this tour.

1. Choose any file, from your desktop or from any other location. Your original
file will not be affected’ by default, drag and drop creates a copy of the file.

2. Size the TheBrain window so that you can also see either the portion of the
desktop cont ai ngoimgto usdoethefwintoe in wiich the e
file is listed.

3. Drag the file into the Plex.

R~ * | |

1 New  Open Select —
el » Tour

and... v O  Search Ma

Name

PLEER] Bina o s ‘ & _
R P oz Directions oTB Buddies
Q- After Sho‘wﬂaces.docx o/ O e O

B2 Directions.doc oNew Bralg Ideas oTips

- o ¢ e ©

@=| Guides.docx oReminders oTo-Do
(0] O
v

- Revival Theaters.docx

Figure 24. File Dragged into Plex Becomes a Child Thought

The new Thought will appear in the Plex and it will include an icon that
represents the type of file. Any time you click this icon in the Plex, the
related file will open.
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@ Thought Pins

.> File Edit Thought View Options Online Window Help

; = Jane's Brain | Health and Fitness \ @

AR A A+ @

2 Personal Life Goals ¢ Hobbies \
Thought Pins

° .
of Persorlal Life

e HeaItI'Tar;d Fitness

Figure 25. Thought Pins in an Existing Brain

The area at the top of the Plex, just below the Brain toolbar functions like a

bulletin board on whichyoucanfind Thoughts you want to keep
fingertips. Thesequick-access shortcuts t @insoNomatteeht s ar e
where you are in the Plex, the pins remain visible.

1. Right-click the Thought named fReminders,othen click Create Pin on the
context menu.

Unlink

l Create Pin

by
Set as Home Thouaht
Toggle a pin for this Thought

® Convert to Typé—er—rog—
oo Dlre% Private
A .
oNew Brair Show History
o 9 Show Thought Properties Alt+Enter

oRemint e I
O O

Figure 26. Create a New Pin

2. Click any other Thought in the Plex. When you want to return to the
Reminders Thought, click the Reminders pin to get there instantly.
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@ Relationship Changes

1. Create a new child of ToufromTomedsinEhpeémdi
gate down a bit, type: Experiments and then press the Enter key.)

2. Now youd vdecided that the Experiments Thought should really have an
equal relationship with Tour, and not be one of its childrend becausey o u 6 | |
use experimenting as much as touring to develop your Brain skills.

Drag Experiments up to the left side of the Plex so that it is level with Tour,
then release the mouse button.

Dragging Experiments ... @
aaasARSEAEEE » c Expe’riments

*
*
K »Tour

L S
og Directions

... then releasing the mouse
when Experiments is in the
“jump zone” of Tour

Expéfimentso Tour

Experiments

—
oNew Brain Ideas

..
Domindare

Experiments is now a
jump Thought of Tour™

$
og | Directions

o/ °
oNew Brain Ideas

Figure 27. Dragging a Thought to Change its Relationship

/ Tip: See the section beginning on page 93 for details about changing Thought
relationships.

<>

“ This is a good place for .¥oubanlkad&yourf youodd I
Brain open or close the Brain window. Just startup TheBranagai n when youbor
ready to continue.

Part 3: Find, Add Attachments, Link, and Delete Thoughts
Itinerary: You 61 | f i nd Tditachngrt to a Thoughd, ddd a web page

to a Thought, use a Thought to open an application, link some Thoughts, and
delete a Thought.
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Your Tour Brain should be on the screen, as you leftitin Part2. Yo u 6 | | begin b
creating a few more Thoughts for a little more scenery along the way.

1. Create four new child Thoughts under TB Buddies: John; Jill; Fred; Ann
(DragfromTBBuddi es® child gate, thebyatype eac
semicolon, then press the Enter key.)

2
oTB Buddi
ug))les

| John; Jill; Fred; Ann

Figure 28. Four New Thoughts

2. Click TB Buddies to make it the active Thought. It should be in the middle of
the Plex.

3. Enter a Note for TB Buddies: We should compare Brains sometime

4. Point the mouse at the Tour Thought and notice how the Note you just
entered for TB Buddies is still in the Content Area.

5. Click the Reminders pin at the top of the Plex to go quickly to your
Reminders Thought. Notice that the Content Area is blank, since you
haven6t created content for that Thought ye

@ Instant Activation

i | n sActavationd i Bsain &eature that lets you quickly find a Thought by
typing a few letters, and choosing fromal i st  oAfter yoldlick he Tdhought
of your choice, that Thought is automatically activated.

Say youdre ready t o &goutwanwvidatddan &tackmeldtto Though
it. With such a small Brain, you could click around and find it pretty quickly, or
you could speed things up:

1. Click in the Search field in the top-right area of the window and type: f
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f ¥ ©

6 matches ] Childward only |= Tour
Thoughts, Links and Events
E @ Fred

= 1

Fun)

Fred

Notes and Internal Attachments

Tour
TB Buddies
@ @ Directions.docx « Directions

Figure 29. Instant Activation

Because you only have one Thought that begins withthel et t er A f
found instantly. If other Thoughts begin with the same letter you will see
them in the box. The more characters you type, the more finely-tuned your
search will become.

, 0 it

2. Click on AFr ed o0 below Thougls, LSh&saand Bvents.iFred d
will be activated.

3. Type

the | etter Aj 0 iedil Noticethebtheastwoc h f i el d
Thoughts n

beginning with tAbteatelDikt ter Aj O

/ Tip: See the Searching Your Brain section beginning on page 48 for details
about more complex searching and the Navigating Your Brain section on page
39 for more on cruising around your Brain.

@ Attachments

1. Back to Fred. Activate Fred by clicking his Thought in the Plex.
2. Click the Add Attachment button, which displays as a + sign, next to the

Notes tab in the Content Area. As you see below, you can add many kinds
of attachments.
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I'm Most Interested In...

Notes ‘ﬂ

| Link to File | / ':"Create File .\:'-.:.BrainBox
| Enter URL | e System Templates
| Add Note | B= Microsoft Access Database
Paste = Microsoft Word Document
| More Actions... | @< Microsoft PowerPoint Presentation

B= Microsoft Publisher Document
Text Document

B Microsoft Excel Worksheet

Figure 30. Add an Attachment

3. You can add an existing file or you can create a new one. For now, select
an existing file on your computer. To do so, click the Link to File button.

4. Navigate to any file on your computer, then click the Open button to attach
it to the active Thought. As soon as the file is attached you will see a
Preview button so you can look at the file right away if you want to. Or you
candouble-cl i ck the filebbs icon in the Conten

5. With Fred still active, click on the Notes tab and notice that the name of the
file you attached now appears as a new tab in the Content Area. Now you
can click on it whenever Fred is active to access and open the file. You
might use this functiontoadda f i |l e youdre a@awdrkshedior ati ng
with dataforaproject youbre completing together.

@ Web Page Thoughts
1. Activate the John Thought.
2. Open your Internet browser and navigate to a web page of your choice.

3. Arrange the browser window and the Brain window so that you can see at
least part of both of them.

4. Drag from the address bar icon in your browser to an empty area of the
Plex, then release the mouse button.
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Ly = @ X

3 Welcome to the Eagle Sc  x
< G) eaglescout.org w

.

L]

: E
o ,rm, Ekg‘&w Oﬂg
Pwu«(«ug‘mol: and y{o‘u > TheBrain

, #nd 2he| File Edit Thought View Options Online Help

. o

% ITour | John ®

.

Welcome to‘E’aglescm O AR A A+@
*
We've collected a l(:ng re
celebration to follows ¢
materials. Whether you are4,
is supporting your very o| *
hundreds, you'll { K

Reminders

L J .
£ oTB Buddies
We've also collected a bit o A 2
the Boy Scouts of A :

¢John og Fred

Figure 31. Inserting a Web Page as an Attachment

The web page will be added as a child Thought of John. When you click the

Thoughtthewe b page wil |l | aun-mnbrowserinthé@mBenti n6s bui
Area.

/ Tip: If you want to add the web page to a Thought instead of creating a new child
Thought, drop the web page on top of the Thought. See the Adding Attachments
to Your Thoughts section beginning on page 174 for details about attachments.

@ Creating Attachments from a Thought

1. Activate the New Brain Ideas Thoughtbyt y pi ng an fAnod in the S
and then clicking on ANew Brain I deaso i

2. Click the Add Attachment button in the Content Area.

3. Click Microsoft Office Word Document in the Create File tab (assuming
this application is installed on your computerd if not, select any other
applicationinthelist. The new document will be

named
matching the active Thought.
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) TheBrain automatically detects file types for many applications that you may

. have installed on your computer and populates the list of available files to
create. Youcanalsoadd templ ates for any file
for new files yourself.

A ClicktheMo r e A c t buttomandselect Template Help to open the
folder where templates are stored, then copy empty files of the types you
want to be able to create from within TheBrain into the folder.

A When you are done, click the Add Attachment button again and chose
one of the templates you added. User Templates will appear in a list
directly above all System Templates.

Once you select a file type, two things will happen:

A First, a new file will be created and added to the Thought (in this example,
a Microsoft Word document named AN

A Second, the file will be automatically opened so that you can work on it (in
this case, starting Microsoft Word).

After you add content to the document and save it, it will be saved internally
within your Brain. When you click on the Thought, the document will open
again.

4. Close the new document before moving on to the next section.

@ Linking Thoughts

One of the most powerful features of TheBrain is the ability to connect Thoughts
to each other. Remember, you can connect any Thought to any other Thought.
For example, say one of your TB Buddies, Ann, is full of ideas on how to use
your Brain. You might want to link her to the New Brain Ideas Thought.

1. Activate the New Brain Ideas Thought( i f it i sno6t still acti

2. Drag from the jump gate on the left side of New Brain Ideas as if you are
going to create a new jump Thought and release the mouse button.

®

.{@m New'quin Ideas]

€
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3. Type the first few letters of the Thought you want to connect (Ann) in the
Create Jump dialog box. Notice that the existing Thought is displayed in
the list below.

Ann -

4. Either double-click on Ann in the list of found entries or click Ann once then
press the Enter key.

Ann -

(@]
e Tour
@

)
Anne {m New Brain Ideasj
o] o

Figure 32. Jump Thought Linked to an Existing Thought

Now that Ann is connected to New Brain Ideas, whenever you look at this
Thought, her Thought will be justa click away. Al so, when you are at
Thought, the New Brain Ideas Thought will be conveniently available.

There are many ways to link existing Thoughts. The method above is convenient
when the Thoughts you want to connect are not both visible, however if the
Thoughts are both visible, you can simply draw the link between the two, starting
from either one of the Thoughtsdgates. Both the Past Thought List below the
Plex and the pins can be used for linking Thoughts visually. When you connect
two Thoughts visually, the resulting relationship will be determined by which gate
you selected to start the linking™ it does not matter where you release the mouse
button over the destination Thought.

@ Forgetting and Deleting Thoughts

I f youbve enteredyauTbomghy donétroeedrto Kk
anymore, you can easily remove it from your Brain. TheBrain offers two ways to
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remove Thought s ' fanddgletingt Wherga Thought is forgotten, it can
be remembered later if need be, however, deleting is permanent.

Letds forget the Thought Jill
1. Make TB Buddies the active Thought.
2. Right-click the Jill Thought.
3. Click the Forget i J i dorhndand on the context menu.

Jill disappears from the display. Now, if you want to show Jill again, turn on
Forgotten Thoughts:

A Click the Options menu, then click Show Forgotten Thoughts.

Any forgotten Thoughts will appear faded.

Showing Forgotten Thoughts X
Reminders
o Tour
o
»
og Directions
e ©
oz New Bra...
. o ©
TB Buddies >Reminders
& ©
oTips
Vi
oTo-Do /
-] (3 '
-Ann S 4______/
o _ v o ©
og Fr_ed &3 John

Figure 33. Forgotten Thoughts

A message above the Plex reminds you that forgotten Thoughts are showing.
You can permanently delete Thoughts or remember them individually or all at the
same time, which is explained in the Forgetting and Deleting Thoughts section on
page 101. To turn off the display of forgotten Thoughts, simply click the X button
next to View Report or click the Show Forgotten Thoughts command in the
Options menu to toggle it off.

/ Tip: If you want to permanently delete a Thought without first forgetting it, hold
down the Shift key (for Windows)/Alt key (for Mac) as you right-click on it and
then select the Delete command.
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Concluding Your Tour

If you click the Home button in the Brain toolbar, your Brain should look
something like this:

'} File Edit Thought View Options Online Window Help = ] X
» Tour | Tour .‘K:.' O
OHRD A ARG = (4
Tour

Notes +

AlE QS| [E ]|

My tour of TheBrain.

0. =
Experimentse Tour

$ ! Jemrprr
om Directions ©TB Buddies
e/ 0 _
om New Brain Ideas 'Z\%Ips
o, (o] ® (o]
©Reminders oTo-Do
4
»
4 > Me Experiments Ann Fred Jill John TBBuddies = New Brain Ideas TDUI;

Figure 34. Completed Tour

Where to go from here? You can stay and experiment more with your Tour
Brain, begin reviewing sections of interest throughout this guide, open the Quick-
Start Brain, or dive into creating your own Brain. You may want to glance at
some of the example Brains at https://thebrain.com/apps for more ideasd but you
probably already have plenty of your own!

/ Tip: If you are ready to dive into beginning your own Brain, start by creating a
few Thoughts for broad categories before you go to the detail level. For example,
if your name is Ed, AEdds Braindo might be t
Thought) and its first children might be Work, Family, Hobbies, and Friends.

gt

This concludes your guided tourd -thanks for coming along!
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Understanding Thought Relationships

Under st aimdiumgdht Rel ati onship

There are no rules governing the relationships between Thoughtsd whatever
makes sense to you is the way your Brain ought to be organized. The three
primary relationship types’ child, parent, and jump’ can be used to express
different types of relationships. Sibling is a relationship that is derived from
child/parent relationships.

The examples in this section can help you understand the variety of relationships
and how they are used. The core concepts behind each type of relationship are
as follows:

A Children: Child Thoughts are usually used to link more specific information or
information that represents a sub-category.

A Parents: Thoughts linked as Parents are usually used to link more general
information. Parents can also be thought of as higher level categories to
classify groups of information. They serve to indirectly connect their child
Thoughts as siblings.

A Jumps: Jump Thoughts are usually used to link two pieces of information
that are exclusively related, meaning that the two items are related to each
other but neither represents a group that the other is a part of.

Letds move on to an exampl e tlmagetpat or e t hes
you are the owner of a company and you are reviewing personnel files. Each

employee has a file. You decide it makes sense to organize your employees by

department. Your Brain is called My Brain. From My Brain, you create a child

Thought called My Company (see Figure 35). My Brain is now My Compan y 6 s

parent Thought. You create four child Thoughts from My Companyd

Manufacturing, Sales, Service, and Billing. These departments are sibling

Thoughts of each other.
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‘) File Edit Thought View Options Online Window Help = ] X
:ﬁ' My Brain | My Company @ 5-:.’ :1
CARDS A A+t @
o, %
oMy Br‘am
@
$My Company |
®
® ®
oBilling oSales
e O o ®
OManufac.turlng OServuoce
|
4 > Manufacturing My Brain  Billing Sales Service My Company

Figure 35. Sample Brain

Now you go to each department and create more child Thoughts, one for each

employee of the department. If an employee splits time between two

departments, you can make him a child Thought of both departmentsd h e 6 | |

appear in both and you wdmthistexam@eyBobisao dupl i ¢
child Thought of both Manufacturing and Sales (see Figure 36). This is one of the

most powerful features of TheBraind having one Thought under more than one

heading.
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') File Edit Thought View Options Online Window Help = (] X

|/ () My Brain | Bob \\ ® 4.' (’©’§

OARS A A+

° . ®
OManufac.turlng OSaIe.s
y
oJoe
S ORancCi)y

Manufactur...  Billing

Sales Service My Brain My Company Bob

Figure 36. Child Thought with Two Parents

If you own more than one company, but have one accountant for all of them, you
might want to make a Thought called Accountant and link it as a jump Thought to

each company, as shown below.
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°> File Edit Thought View Options Online Window Help = O

X
. A
|/ )My Brain | Accountant \@ ' (@)
CARS A A+ @

My C.orr;panyo
My O’ch%r Co...e

¢ Accountant |

Manufactur... Billing Sales Service My Brain My Company Bob Accountant
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Figure 37. Jump Thoughts to the Active Thought
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Imaginet hat Joeds company has just .bmechased o
Joe& company now owns thiscompany, Joeds Company eecomes a

below).
.> File Edit Thought View Options Online Window Help = m] X
aw: ()
g My Brain | My Other Company @® ’ Y
OCARS A A+ @~ (Y
, Q o .
oJoe's Company oMy Brain
@ ®
@ ©
Jg My Other Company] My Company
4
4 > Manufacturing  Billing Sales Service My Brain My Company Bob Accountant My Other Com...

Figure 38. New Parent Thought

Because Joe wants to avoid a conflict of interest, the acquired company (My
Other Company) no longer uses the same accountant. So its jump gate is hollow,
while its siblingbds jump gate (My Company)

As you use TheBrain, you will develop a sense of the types of relationships you
wish to make between Thoughts. It is always easy to change relationships by
adding and removing links (see Changing Relationships Using Drag and Drop on
page 109).

Families of Thoughts

It is tempting to view Thought relationships as families, and indeed these
different parts of your Brain are types of families, with their ancestry visually
spread before you, represented by subjects and categories. But unlike human
families, a child Thought can be a parent of one of its siblings and a Thought can
have more than two parents.

The complex relationships you can form in TheBrain are the source of its power.
Letds consi der ataldkhare gparéri/child gelatiosshig. h
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Understanding Thought Relationships

Letds say you ar e.Youtmglt gaveragrhopghticdllels o p h'y
Philosophy. Individual philosophers such as Plato and Aristotle could be child
Thoughts of Philosophy. Each of these siblings, in turn, may have child

Thoughts. Aristotle was a student of Plato, so you may want to make Aristotle not

only a child of Philosophy, but of PI
Aristotle, Plato is only a Thought away.
‘) File Edit Thought View Options Online Window Help == =] X
My Brain | My Other Company Philosophy | Aristotle ® 5:.’ 8
CARDS A Ar@ [
>Philosophy /5Iato
Aristotle Theories
©Dialogues ©Meaning of Life
<
Philosophy  Plato  Aristotle
Figure 39. Example of Parent/Child Relationships
Noticethatwhen Phil osophy and Pl azopoe,tkeire i n

relationship (Philosophy is a parent Thought of Plato) is shown by the line linking
the child gate of Philosophy to the parent gate of Plato.

Clearly, TheBrain is a powerful method of organizing ideas and information. No
hierarchical file structure can provide as much cross-referenced information at a
glance. And our example is pretty basicd a fully developed Brain can hold many
more relationships and much more information.
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Navigatingi Nour Br

All Thoughts can be connectedd directly or indirectlyd even Thoughts that may
seem to have nothing to do with each other can be related through a chain of
links.

Let 6 s dnexampleaay, the Queen of England and asparagus. You have a
Thought called Queen of England. One of its child Thoughts is Prince of Wales,
which has a parent Thought Famous Princes that is also linked to the story of the
Frog Prince.

oFamous Princes éQueen of England

s

¢Prince of Wales oFrog Prince

The story has another parent Thought called Fairy Tales. A sibling of Frog Prince
is Jack and the Beanstalk.

OFalry Ta[es oFamous Prmces

¢Jack and tﬁe Beanstock )
oLittle Red Rndmg hiood
978 oMother Goose

oPrince. of Wales

Jack and the Beanstalk has child Thoughts called Giant and Jack. Giant has
another parent Thought called Famous Giants.

$Famous .Giants oJack and t%e.Beanstock

(Giant)

Pe)
oJolly Gree.n Giant

Famous Giants has a child Thought called Jolly Green Giant. Jolly Green Giant
has child Thoughts named after canned vegetable products, one of which is
Asparagus. Thus, the Queen of England is connected to asparagus!

o Famous Glants

q JoIIy Greehmnt

.
©Asparagus oPeas
) o o
oCorn
o
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Depending on the relationship you create between them, Thoughts may be
closely or distantly related. Thoughts are considered to be closely related when
they are linked directly or are siblings. In the default view of the Plex, only close
Thoughts of the active Thought are always displayed in the Plex. Thoughts that
are one additional step (generation) away from the active Thought can be
displayed by expanding the view. See Advanced Navigation and Alternate Views
on page 143 for information about the different view options.

Opening a Brain

When you log into TheBrain 11, and no Brain is open, all local, synced or online
Brains will be displayed as thumbnails in the Brains tab, as shown below. This is
assuming that you have already created one or more Brains. Clicking on a Brain
thumbnail opens that Brain.

°> File Edit Options Window Help - a X
Brains D :ﬂ.’ =
©+ | C |z
/ - ’-—-"~
Jane's Brain Product Research
Marketing Philosophy

Figure 40. Example of Three Available Brains on the Brains Tab

By default, Brains are listed according to how recently they have been accessed.
You can also see the list of Brains sorted alphabetically using the Brains tab
toolbar, shown below. All Brains that are locally available are shown first,
followed by Brains that are available online.
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@TheBrain
File Edit Options Help

/ =/ Brains @
Sort Brains by last

yad 2 C][A-Z] 4" accessed date

Create a

new Brain H
Refresh Sort Brains by name

Figure 41. The Brains Tab Toolbar

The status of whether each Brain is available locally, online, or both is also
displayed. Each Brain in the Brains tab will have an icon appearing in the lower
right-hand corner of the thumbnail. Right-click on a Brain or click on the status
icon to display a menu of options for that Brain, as shown below. The
appearance of the icon(s) help you identify whether the Brain is Local, Synced
(local and online) or Online only.

P o

Product Research

Figure 42. Icons Indicating Local, Synced, or Online Only

Local
Synced
Online

Figure 43. Status Indicator Icons
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Opening a Brain that HRBarsdabdt Appear

If you have a Brain from an older version or from a backup, it will not appear in
the Brains tab until you import it. Click the File menu, then the Import command.
Choose the type of file you want to import, then click the Select File button,
navigate to the .Brain file of your choice, then click the Open button when the file
is selected. Click the Import button after TheBrain has finished converting the
Brain.

Managing Brains Using the Tabs

The tabbed interface of the Plex lets you switch instantly between Brains or even
keep the same Brain open in multiple Brain tabs or windows

To re-open the Brains tab to display the Brain thumbnails, click the + icon to the
right of the last tab.

@ TheBrain

File Edit Thought View Options Online Help

—IOne Brain for It All | I'm Most Interes...

ARS A A+ @

4* Personal Life %! My Work

Figure 44. Click the + Icon to Open the Brains Tab

open a Brain it will appear in a separate tab. Switch from Brain to Brain
instantaneously by clicking its tab. All tabs and their states are automatically
saved and restored when you quit and restart.

) There is no limit to the number of Brains you can open at once. Each time you

A Float tabs into their own dedicated window by dragging a tab out of TheBrain
application window. This creates a new Brain application window with just a
single tab.

A Merge tabs into one window by dragging and dropping. Click the tab of one
Brain window and drag the tab to another open Brain, hovering over the tab
area. Then release the mouse button.

A Open the same Brain in multiple tabs to view and edit multiple areas at a
time. This lets you view different areas of your Brain at the same time, and, if
you like, use a different layout in each tab. Note that tabs are simply views
into the same Brain data and changes made in one tab affect all other tabs of
that Brain.

A Duplicate Tabs. Right click on a brain tab to duplicate it, showing the same
content in a new Brain tab.
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Opening Content Associated with a Thought

As you navigate through your Brain, the content associated with the active
Thought is displayed in the Content Area. Notes associated with the Thought are
displayed automatically. There are several ways to open an attached file or web
page:

A Click on the tab for the attachment, then click the Open icon.

A Click on the attachment icon in the Plex.

A Right-click on the Thought, then click Open Attachment on the context
menu.

Showing Thought Content on Hover

By default, the content for the active Thought displays in the Content Area. If you

prefer, you can display content for any Thought your mouse pointer hovers over

by changing the setting. To do so, click the Options menu (TheBrain menu on

macOS), click Preferences, click the Behaviort ab, t hen sel ect the f
di splayed content o sethe®neferences evindow wherb o x . Clo
youodre finished.

Previewing Thought Content

Certain types of file attachments are automatically previewed inside of TheBrain.

These include web pages, images, text, markdown files, JSON, .html files and

PDFs. Simply click on an attachmdmtheds tab a
example below, Tropical Getaways is the active Thought and there are two

attachments in the Content Aread a Word document and an image. The tab for

the image has been selected.
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.> File Edit Thought View Options Online Window Help = = X
7 Al
/ lsane's Brain | Tropical Getaways \ @ 5‘ CQ’)
CARS A A e =N J ¥ ©
A Personal Life Goals &5 Hobbies = MapOfoahu.png aways
Notes Tropical Getaways.docx F L= +
-~
MapOfOahu.png
Internal
— 116.62 KiB
- Modified: Jul 15, 2018, 2:01:46 PM —
Created: Yesterday, 3:33:35 PM o a h u

o® My Latest.Preoccupations

-Chocooholic.“

Jack
Michael G
-~ —& ichael Graves
Tropical Getaways Ne ©
(é‘“z P y ]\oSumme%Plans
ol 1'heoatre
of® Tt!egrain
< P> ‘|Hea ETheatre s=Chocoholi.. My Latest... = Tropical G;;

Figure 45. Content Area for the Active Thought

The PDF preview features:
Supported rendering for each OS
Very large, multi page PDFs

Thumbnails of each page, zoom, rotation, search and printing

= == = =4

All PDF commands can be mapped to a custom keyboard shortcut

Editing Additional Attachments

Adding additional attachments to a thought, such as .md and .txt files will enable
you to also edit these attachments the same as you would a Brain Note. To
quickly add an additional Note to a Thought, click on the Add Attachment tab
and select Add Note.
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+|

Tropical Getaways
Notes '@ Tropical Getaways.docx &l MapOfQOahu.png
| Link to File | Create File \ BrainBox
| Enter URL | e System Templates
| Add Note %J B Microsoft Access Database
Paste @= Microsoft Word Document
| More Actions... | @- Microsoft PowerPoint Presentation
B= Microsoft Publisher Document
Text Document
B Microsoft Excel Worksheet
Figure 46. Adding an Additional Note
Pins

As you saw if you went along on the Guided Tour of TheBrain earlier, pins are
shortcuts to Thoughts to which you want quick access. They appear at the top of
the Plex, just below TheBrain toolbar. No matter where you are in your Brain, the

pins remain visible.

°> File Edit Thought View Options Online Window Help = O X
P2
/ == One Brain for It All | My Brain \ @® M ht P ’ (\Qy
ou Ins
AR A R :/' g ! |
4» Personal Life [ i My Work ]

- —— 7 e
e — i

Goals
o@I'm Most Interested Ins
o \NTy Work

o'/ What I'm Thlnk(;ng About Now

oge Personal Life

Figure 47. Pins
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To create a pin:

A Right-click the Thought for which you want to create a pin, then click Create
Pin on the context menu

My Br.aln

¢ Goals Open in New Tab
Jd o1

— One Brain for It All | My Brain @ Open in New Window
i Create Child

CARS A e Pins before .... il
Create Jump

—

2 Personal Life [l My Work] Set Type
Set Tags

S Vacati.. *< Airlin

S S Add Attachment
Create Event
— One Brain for It All | My Brain @ basteimage

Open Thought Folder

‘ ﬁ '2 ‘ AA ‘ Select Stock Icon

Capture Image

Paste Icon

[ﬁPersonaI Life My Work | Goals]

Copy "Goals"

J Copy Local Thought URL
... after creating the new pin S A et e
Duplicate Thought

b

Create Pin

Set 2 Hoo Thoyoht

Figure 48. Creating Pins
To remove a pin:

A Right-click the pin or on a Thought that has a pin, then click Remove Pin on
the context menu

/ Removing a pin does not remove or delete the associated Thought; it deletes
. only the reference to it at the top of the Plex.

To use a pin to link Thoughts:
A Drag from one of the Thought gates to the pin, or

A Move your mouse pointer over a pinned Thought and gates will appear; drag
from one of these gates to the Thought you want to link

Activating Recent Thoughts: The Past Thought List

TheBrain keeps a running breadcrumb trail of your Thoughts based on activation

and displays it in the Past Thought List. You can think of the Past Thought List as

the visual representati onod adcrolaltledistgfhr ase, ft
Thoughts in the order you activated them. The Past Thought List is displayed at

the bottom of the Plex window.
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Clicking on any Thought in the Past Thought List activates that Thought. Also,
when a new Thought is created it appears in the Past Thought list immediately.

Scrolling arrows

[- 4ii> i Tropical Vacati... "Airline Rewards...  {i Jrban Travel § New York My Brain

a-v-3-£1

Figure 49. Past Thought List

The arrows located to the left of the Past Thought List enable scrolling to see
items that dondt fit on the display

The most recently activated Thought (the current active Thought) appears at the
right end of the list.

To use a Thought in the Past Thought List to link Thoughts:

A Drag from one of the Thought gates to one of the Thoughts in the Past
Thought List, or

A Move your mouse pointer over a Thought in the Past Thought List and gates
will appear; drag from one of these gates to the Thought you want to link

In the example below, Tropical Vacations is going to become a parent of Airline
Rewards; the mouse is being dragged from the parent gate of Airline Rewards to
Tropical Vacations.

File Edit Thought View Options Online Help

' L) One Brain for Everything | Goals @

CARS A G |

¢ Tropical Vacations)
o

S

| é
< > . o AirIiQ %eward...

Figure 50. Creating a Link from the Past Thought List
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Using the Back and Forward Buttons:

A In addition to the Past Thought List, you can also use the Back and Forward
buttons, located near the top of the Window, to quickly retrace your steps;
these buttons work just like they do in a web browser

@TheBrain
File Edit Thought View Options

—! One Brain for It All | Tropical Vacations

[<>ﬁl2$ Al A+ @

A Click the Back button to go back to the last active Thought

A Once you have clicked the Back button, the Forward button can be used to
re-activate the Thought you came from

M Back and Forward Mouse Buttons: The back and forward buttons available on
some mice (typically on the left side of the mouse near where you place your thumb)
may be used to navigate backward and forward in your Brain. These mouse buttons
perform the same navigation as the Back and Forward buttons in the Brain toolbar,
shown above.

Searching Your Brain

Instant Activation

TheBrain includes powerful search capabilities. The Search box is in the top-right
area of the application.

Figure 51. The Search Box

The term AinstarfeastitovoaTheBrainds abili
youdre searching for andVYacanheasgilgdcanthe he r e
search results as you type in the Search box. There's no need to click in the

Search box, your cursor is always there by default, unless you are actively typing

in the Notes tab or another field.

ty
| at

To activate one of these results, click it with your mouse or use the up-arrow,
down-arrow, page up, and page down keys on the keyboard then press the
Enter key.
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res | ;

6 matches [] Childward only |=

Thoughts, Links and Events
Restaurants
S Human Resources
I IT Resources

.+ Product Research

Notes and Internal Attachments tere

- o F U

Figure 52. Instant Activate Finds Matches Based on Thought Names,
Labels, Notes, and Attachments

Accents are ignored when matching Thought names. Also, when two or more
[ matches with the same name are found, the names of their parent or jump
Thoughts are also displayed so you can differentiate them.

You can search for Thoughts by typing the first letter(s) of separate words and
the |l etters can be in any sequence,;
Thought you €éoubdorypérifa, 6 or dfa

F ()
|fafr |; 0

1 match [ ] Childward only | =

Thoughts, Links and Events

Figure 53. Use First Letters of Separate Words for Instant Activate
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Attachments and Note search matches are identified with a yellow piece of paper

icon for Notes and a paper clip icon for Attachments.

mar

14 matches
Market Trends
- s . .
an Vice President of Marketing
@ Target Markets
Online Marketing
Notes and Attachments

=) !_ Increase Sales

=) - Territories
VIP Clients
Marketing Events

Marketing Events.xlsx « Marketing Events
Marketing Events.docx « Marketing Events

S © Wl

[] Childward only | =

A

Figure 54. Search Results

When you do a search, the results are sorted with results that match Thought
names first, then notes, then attachments. Within the Thought name matches,

they are ranked in groups:

A Exact Matchesd where the entire name of the thought matches the entire

query

A Starting Matchesd where the entire query occurs at the start of the Thought

name

A Continuous Matchesd where the entire query occurs anywhere in the

Thought name

A Matchesd where every term in the query occurs somewhere in the Thought

name

Within each group, Thoughts that have been activated in the last 30 days will be
shown first, ordered with the most recently activated first. Thoughts that have not

been activated within 30 days are sorted alphabetically.

Activate a Thought
Enter without waiting for search results to appear.

gui ckly

by typing

Searching within Attachments

Your searches automatically include matches based upon the contents of

attachments. | f t he

TheBrain 11 User Guide
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PDFs, Word, Excel, PowerPoint and many other file formats, the documents
containing the text will be found.

On Windows, TheBrain utilizes Windows Desktop Search to provide search
results to Brain notes and file attachments.

TheBrain integrates with Spotlight on macOS to provide search results from
within file attachments. No setup or additional steps are required to enable this
functionality.

Y
~ R

For searches in TheBrain to return accurate results, Windows Desktop Search
or Spotlight will need to have access to the location where your Brains are
being stored. For more information on your Brain storage, see page 75.

.

Additional Search Functionality
Search now has several additional capabilities that are automatically enabled.
1 External attachments are included in search results

1 Search using automatic acronyms (ex. find "New York Stock Exchange"
by typing "nyse")

9 Search for thoughts starting with punctuation. You may use this as a
shortcut to provide fast access to thoughts that you always start with a
certain type of punctuation. For example, you could use this for people

(@Mike, @Sally, @Debbie, etc.) or projects (#Ridgeline, #Palmdale,
#Westly, etc.)

J _l July
2 matches [ | Childward only |=

Notes and Internal Attachments

« Villa House
External File Attachments

@ 8 July.docx « 3rd Quarter Invoice

Figure 55. Search Finding External Attachments
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Customi zing Your Brainods En:

You may choose touse yourBrainj ust as ités offered Aout o
choose to change some of the environmental settings to suit your personal
preferences.

TheBraind ®efault Settings

Wit hout making any c h8raigleokslikeher eds what you

A The area where your Thoughts appear (the Plex) will be the color and design
of one of AT HediEe initiabtkeme is randomly selected and
you can change it at any time.

A The left half of TheBrain window will display your Thoughts and the right half
of the window will display the AContent A
other items you will attach to your Thoughtsd files, web pages, Events, etc.

A Your Thoughts wil! b e ,dneamipglthatyaidvilse@ A Nor ma
only the direct parents, children, jumps, and siblings of the active Thought.
-} File Edit Thought View Options Online Window Help = o X
One Brain for Everything | My Brain i.‘.l 7;
AR A A+@- = LY
4 Personal Life My Work | Goals My Brain
Notes | +
A K B 7 Fl+|iziz@|=

{My Brain)

o| .Go.als of Per‘sorlal Life
o I'm Most.ln'gerested In.. o What I'm.Thinking Abo...
.5 My \ﬁVork
3
4 p My Brain t‘;

Figure 56. TheBrain Window with Default Settings

Using Smart Splitter to Arrange TheBrain Window

The smart splitter controls let you manage where the Plex and Control Area
display relative to each other in TheBrain window.
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’) File Edit Thought View Options Online Window Help

- (m] X
- P
==/ One Brain for Everything | New York (= Brains ® a’ e
CARS A A @ = /% |®
24 Personal Life g My Work ‘ k The Empire State Building ‘ New York
Notes ‘ 7= ‘ +
s &) h https://www.nyctourist.com/empire1.htm g

TOURIST

offi Urt:an.Trave[ Photo Tour Homepage
) cCI%caLgo Photo Tour Homepage
olos zngeles
14 New York $ 5 THE EMPIRE STATE BUILDING
€ oSan Francisco
CTBkyp

Toggle maximizing left side 4
Toggle maximizing right side )
Toggle plex/content left/right «»

Toggle side/side over/under 44

fva

< > [-rHeal..] LosAngeles SanFrancisco figUrban Tra.. g New York .

Figure 57. Smart Splitter

A Click the individual left- and right-arrows (or up- and down-arrows if the
wi ndow i sandium dfea W etomaxdngze the area the arrow is
pointing towards (either the Plex or the Content Area).

A Click the double-headed arrow icon to toggle the Plex to the right or left side
of the Content Area.

A Click on the two-arrow icon that forms a box to toggle between seeing the
Plex and Content Area "side-by-side" o r fand-emder . 0O

A You can also point at the border between areas and click and drag when the
double-headed arrow appears to move the border.

Moving Thoughts in the Plex

When the default settings are inuse andthePlexi s i n fANor mal 0 view,

move the Thoughts in the Plex up or down by dragging (up or down) in any blank
area of the Plex background.
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= Tour | Tour
ARS A A @
Reminders
[ Before dragging
"« Plex down
-
-
Experimentse ‘-
i A -
-
-
.
o' Directions T8 gud.dles “
e New’BrajnIdeas fip; “
Reminders Tc'»Dp “
' .
file Edit Thought View Op‘.lc&s Online Help
—Tour | Tour %
.
AR A A “
Reminders ‘.
.
.
.
.
< > a New Brain Idi “
.
.
.
.
.
.
.
‘l
[
Expérimentse {Tour) After dragging
Plex down
a Directions T8 gud.dles
o' New Brain Ideas ips
Reminders To-Do 4
g . »
< ! @ New Brain Ideas TB Buddies [&John Tour;

Figure 58. Dragging the Plex Vertically
Resizing the Thoughts in the Plex

The Plex is the heart and soul of TheBrain. You can change the size of Thoughts
in the Plex by using TheBrain toolbar or your keyboard and mouse.

To change the size of Thoughts using the toolbar:

A Click the AA button to activate the slider, then click and slide the bar up or
down to grow or shrink the size of your Thoughts.
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I Tour | Tour

)
ARV A|A S

Reminders

o Directions
)
ea: New Brain Ideas
o
oRernmgers

T8 duddies
olips
oT8-Do

X

Brainos

To change the size of Thoughts using the keyboard, mouse, or trackpad:

—ITour | Tour

AR
Reminders

o,
Experimentse—————— Tou‘r

o _—
om- Directions
e/ ©
ex New Braoln Ideas
.-
ORemmglers

®

J

oTB Buddies
o ®
oI|pg
oTo-Do
(o]

Figure 59. Resizing Thought Size with the Slider

A Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and scroll up or down

on your mouse wheel or trackpad while your mouse pointer is in the Plex.

A Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and press - to make

Ctrl-’1 / &ﬁ “ + or

Thoughts smaller or + to make Thoughts larger.

TheBrain 11 User Guide
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Figure 61. Resizing with the Keyboard

+ |- Jor|l

1

4
t

Figure 60. Resizing with the Mouse or Trackpad
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A Pinch to zoom on a macOS Trackpad.

LARGER SMALLER

Figure 62. Resizing on a Trackpad
Customizing Your Brainbs Appearance

Selecting a Theme

The Themes feature lets you choose from many built-in designs to customize the
look of your Brain, including the appearance of the Plex and Notes in the Content
Area. You can change many of the default colors and the style of Notes
associated with the Theme, then save the look of your Brain as a new Theme.
This lets you quickly switch from one saved Theme to another.

e File Edit Thought View Options Online Window Help = a5

) Jane's Brain | Jane's Brain E (>

®» file Edit Thought View Options Online Window Help - o x
— - ()
() Jane's Brain | Jane's Brain D S ~

AR A A ©

APersonal Life - Goals ..<Hobbies

;}BJan—e's Brain |

¢@Jane's Brain

als & My Work

4 NT erested In... o Personal Life
.Go.als =B .y \‘Vork Poccupations @ What I'm Thinking About Now
£ I'm Most Interested In... 2 Personal Life <
o@ My Latest‘Prgoccupations o WhatI'm Th.lnk.ing About Now Wane’s Bramn
[«» Eane's Brain —

'IT)Jar;e's Brain

@ Jane's Brain

o aMy !Vork
* Goals of: My Work > 2 Personal Life
® I'm Most Interested In... & Personal Life g o~ What I'm Th’lnk.ing About Now
L]

My Latest Preoccupations @ What I'm Thinking About Now 1

Rane’s Brain

[@)ane’s Brain

Figure 63. Sample Themes
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To select a Theme:

Customi zi

ng Your

1. Ether click the Options menu in TheBrain toolbar (TheBrain menu on
macOS) or right-click any blank space in the Plex.

2. Click the Brain Theme command.

'> File Edit Thought View | Options | Online Window Help

’f' (¢ One Brain for Everything | My E
RS A A

A Personal Life _gMy Work |

Arrange Thoughts by
Web Search

Show Forgotten Thoughts
Hide Private Thoughts
Wander

Check Spelling as You Type

F4

Brain Theme... .

Preferences...

! Alter the look of this brain |

Br ai

—

Paste

Arrange Thoughts by
Layout

Expand All

Collapse All

Report

Timeline

Ctrl+0

Ctrl+9

Brain Theme... N

Presentation Mode

! Alter the look of this brain W

Figure 64. Accessing the Brain Theme Window

In the Brain Themewi nd o w,

youdll see

a scrol

left panel and Colors and Options tabs in the right panel. Click on any Theme to

see how it looks in the Plex.

TheBrain 11 User Guide
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o)
Themes Colors \ Options
Custom Settings Background, center @)
Background, top and bottom O
- Classic Dark Blue Thoughts, text ®
. Thoughts, text shadow @)
- Light Blue Default '
9 Thoughts, background O
# 20 Years Highlighted Thoughts @
) Links

# 20 Years-Light Highlighted Links ()
# Brain Animals Gates ®
Highlighted Gates o
# Brain Animals-Light Active Thought, outline @
. Focused Thought, circle @

#B W 1 . '
rain iaves Scrollbars, fill @
# Brain Waves 2 Scrollbars, outline ®
@

Highlighted Scrollbars

Figure 65. The Brain Theme Window

CustomizingaThemebés Col or s

, Have the Brain Theme window open when you want to customize a Theme
. (right-click a blank area of the Plex, then click the Brain Theme command).

The default colors for virtually all items in the Plex vary based on the selected
Theme. The current color for each item is shown in the circle to the left of the

i t emds d.sSeralthioygh thedist in the Colors tab to get an idea of all of
the items that can be changed.

To change the colors in the selected Theme:

1. Click the item whose color you want to change to display your choices.
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£3) Brain Theme X
o} Go.als/ h
of I'm Most Interest s Y \Dptors
e ® - Classic Dark Blue (o) £ O Background, center £
*«a My \‘VOI’k - Light Blue Default O Background, top and bottom
# 20 Years @ Thoughts, text
# 20 Years-Light © Thoughts, text shadow
# Brain Animals O Thoughts, background
# Brain Animals-Light @ Highlighted Thoughts
# Brain Waves 1 | %Links
# Brain Waves 2 M Highlighted Links
# Brain Waves 3
# Cold Ocean 3
# Dark Garden utline X

Custom

Figure 66. Color Choices in the Colors Tab

Click the color of your choice, then click outside of the box of colors to close

it.

e
o Goals

)
of" I'm Most/ n'gerested In
e.g My \i\/ork

TheBrain 11 User Guide

Themes / Colors { Options
Custom Settings ol O Background, center 2
- Classic Dark Blue O Background, top and bottom
- Light Blue Default @ Thoughts, text
# 20 Years © Thoughts, text shadow
# 20 Years-Light O Thoughts, background
# Brain Animals @ Highlighted Thoughts
# Brain Animals-Light @ Links
# Brain Waves 1 M Highlighted Links

# Brain Waves 2

# Brain Waves 3

L #Cold Ocean utline v
. Custom
Figure 67. New Selected Color for Links
59

noés

E
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Brai nods

Note that while you can change the color of the shadow for Thought text using
t h e t hCelordab settings, you can toggle whether or not text shadows
are displayed using the Look & Feel tab of the Preferences window (as
explained in the Look & Feel Preferences section on page 72). By default, text
shadows are displayed.

4

When you are happy with your color selections, click the close button (X) in the
Brain Theme window.

Defining and Selecting Additional Colors

Youcanaddaddi t i
want.

onal customi zed col ors i

1. Inthe
t hen

button.

col or
click

s el box, click
t

Default @ Thoughts, text

M Thoughts, text sha

ght

.|| Custom colors:
3

| HEEEEE
| HEEET
(11 FHHANEE
(1] HEEENT

=
_I
.

=
R
H
H
H

Define Custom Colors >>

v

| OK l Cancel l

2. The Color window will expand to provide a slider to fine-tune the shade.
You can also select a different color and fine-tune it or type in specific RGB
or HSL numbers. Click the Add to Custom Colorsbut t on when
happy with the sample color, then click the OK button.
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Color X
Basic colors:

Il It T \
H METEHNE

ENNEEEN

HETEEEEN

EEEEEEN

EEEEE N

Custom colors:

EEEEEEN r—
EEEEEREE Sat[240  Green:[206

[ e Custom Colors >> | L colorjSolid Lm 217 Buel[2ss

OK Cancel | Add to Custom Colors l]'

Selecting a Custom Image for the Plex

Brai nods

If you want to use an image of your own instead of using one in the Themes list

of the Brain Theme w i

ndow,

tbs very

To select your own background image:

easy

1. Click the Options tab in the Brain Theme window, then click the
Wallpaper check box.

Themes

@ Brain Theme

TR SRR Y Y]

# 20 Years-Light
# Brain Animals |
# Brain Animals-Light
# Brain Waves 1

# Brain Waves 2

Y

| Colors / Options
Custom Settings - Plex
- Classic Dark Blue [] wallpaper
- Light Blue Default .
Font | Helvetica Y
# 20 Years
Notes

Edit Notes Style |

TheBrain 11 User Guide

Figure 68. Options Tab in the Brain Theme Window

t o

do so.
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Customizing YourBr ai n6s Environme

2. Inthe Select image file as the wallpaper window, navigate to the location
of your image file, click on it, and then click the Open button. Supported
wallpaper file formats include .jpg, .gif, and .png.

3. Click the close button (X) in the Brain Theme window to save your new
image for the Plex.

To replace or remove a wallpaper image:

A To replace the image, click the Select button next to the Wallpaper check
box to navigate to a different image.

A To remove the image, click the Wallpaper check box to toggle off the check
mark and remove the image from the Plex.

Colors Options
/ s

Plex

Wallpaper | Select...

Font | Helvetica ~

Notes

Edit Notes Style

Figure 69. Replacing or Removing Wallpaper
To dynamically select new Wallpaper from a web site:

1. Go to a web site that offers Wallpaper files, right-click the design of your
choice, then select Copy on the context menu.

2. Return to your Brain, right-click in any blank area of the Plex, then select
Paste Wallpaper on the context menu.
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Paste Image

Paste Wallpaper |\

\X

Arrange Thoughts by 4
Layout ’
Expand All Ctrl+0
Collapse All

Report

Timeline

Brain Theme...

Figure 70. Context Menu on the Plex

Changing the Default Text Font in the Plex

Br ai

By default, the font for text that appears in the Plex is Helvetica. You can change

it to any font installed on your machine:

1. Click the Options tab in the Brain Theme window, then click the drop-
down button for Font.

£2) Brain Theme X
Themes Colors , Options

Custom Settings Plex
- Classic Dark Blue [] wallpaper
- Light Blue Default .

Font | Helvetica v
# 20 Years Cambria Math
# 20 Years-Light Notes Candara
# Brain Animals I: Candara Light
# Brain Animals-Light Castellar

Centaur

# Brain Waves 1 Century
# Brain Waves 2 Century Gothic N |
P VPR Century Schoolbook

CF Cherokee

CF Old Milwaukee port

Chiller ——
Colonna MT

Comfortaa

Figure 71. Changing the Font for Plex Text

2. Click the font of your choice. You will see the text in the Plex update
automatically.

TheBrain 11 User Guide
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Changing the Default Notes Style

By default, the Notes in the Content Area of your Brains appear in a style called
i Mo d,ewhich is a sleek and clear combination of font, color, and size.

To select a different style for Notes:

Click the Edit Notes Style button on the Options tab in the Brain Theme
window. There is also a Notes Style button in the Notes Toolbar.

/ Colors Options
/ ¥

Plex
[ ] Wallpaper

Font | Helvetica

Notes

Edit Notes Style

[
by

Figure 72. Changing the Style of Notes

In the Edit Notes Style window, click on any paragraph or heading to change the
font, justification and line settings for that paragraph or heading type. For further
variation, italics can also be toggled on or off.

You can also select custom colorsfory o ur  Next, lenkss Page, Edge and
Background. Some Prebuilt Styles are also available. When selected or modified,
the Note preview in the right column of the Edit Notes Style window will be

updated.
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| @ Edit Notes Style
i

| Click a paragraph or

heading to change the

. font, justification and
line settings for that
paragraph type.

Colors
Text
Link
Page
Edge
Background

Prebuilt Styles

Custom
Modern
Magazine
Classic
Foundation
DelRey
Deco

Draft

cee

Customi zing

Title Example Text

Click here to change settings for normal paragraphs. Clicking a title or
heading to change their settings. Colors can be modified using the controls

to the left.

Heading Examnla Tavt

Lorem ipsum dolor sit amet, consecte
tempor incididunt ut labore et dolore n|
nunc aliquet bibendum enim. Link exa

Subheading Example Tex

Egestas egestas fringilla phasellus fay

orci a scelerisque purus semper eget

Heading

Font:
Weight >

Italic

Left Justify

Right Justify

Line Above

Line Below

eiusmod
Iverra ipsum

d. Sagittis
sit amet nisl|

suscipit. Sed adipiscing diam donec adipiscing tristique risus nec feugiat
in. Fusce ut placerat orci nulla. Pharetra vel turpis nunc eget lorem dolor.
Tristique senectus et netus et malesuada.

« Dignissim suspendisse in est ante in.

» Volutpat commodo sed egestas egestas.

 Felis donec et odio pellentesque diam.

e Pharetra vel turpis nunc eget lorem dolor sed viverra.

Figure 73. Custom Note Style Options

Your

Br ai

When you are happy with your Notes modification choices, click the Apply button

and X in the Brain Theme window to save your new Notes styles, which are
applied immediately.

Reverting to the Original Themed ®efault Settings

, Assoonasyouma ke any changes to a

selected in the Themes list.

Theme,

TheBrain 11 User Guide
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* 2 Edit Notes Style
|

Click a paragraph or

heading to change the

font, justification and

" line settings for that

paragraph type

Colors
Text
Link
Page
Edge
Background

Prebuilt Styles

Custom
Modern
Magazine
Classic
Foundation
DelRey
Deco

Draft

Cee

Customi zing

Title Example

Click here to change settings forn
heading to change their settings. C
to the left.

Heading |

Lorem ipsum dolor sit amet, conse
tempor incididunt ut labore et dolo
nunc aliquet bibendum enim. [Link

Subheading Example T

Egestas egestas fringilla phasellus
orci a scelerisque purus semper e(
suscipit. Sed adipiscing diam done
in. Fusce ut placerat orci nulla. Ph:
Tristiaue senectus et netus et mal

Figure 74. Selecting a Prebuilt Style

Your

Br ai

To switch back to the original settings for any Theme, select the Theme name in
the Themes list within the Brain Theme window.

Saving Themes

1. Make sure the tab with the Brain that has the Theme you want to save is

TheBrain 11 User Guide

active in the Plex.

Unless the Brain Theme window is already open, either click the Brain
Theme command on the Options menu or right-click a blank area of the

Plex, then click the Brain Theme command.

Click the Save Theme button, then type a name for your new theme in the

field.
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# Cold Ocean

| OK Ml Cancel ]M
L2

Customi zing Your
@ brai er
Themes / Colors ( Options
Custom Settings % (O Background, center -
- Classic Dark Blue © Background, top and bottom
- Light Blue Default @ Thoughts, text
# 20 Years © Thoughts, text shadow
# 20 Years-Light O Thoughts, background
# Brain Animals @ Highlighted Thoughts
# Brain Animals-Light @ Links
# Brain Waves 1 @ Save Th;eme X
# Brain Waves 2
# Brain Waves 3 lMy Nl Theme| I

Figure 75. Save a Theme

4. Click the OK button. Your new Theme will be inserted into the list of

Themes, ready for use in your other Brains.

@ Brain Theme

Themes

Colors ( Options

# Mist Covered Mountains *

# Mystic Lake

# Painted Sky

# Polygon Gray

# Relaxed Ocean

# To the Woods

Dark Gray

Dream Logic

Light Gray

My New Theme Ik

Purple Prince

O Background, center

O Background, top and bottom
@ Thoughts, text

© Thoughts, text shadow
(O Thoughts, background
@ Highlighted Thoughts
@ Links

@ Highlighted Links

@ Gates

@ Highlighted Gates

v @ Active Thought, outline

Figure

76. Newly Saved Theme in the Themes List

Br ai

4

Your saved Theme will also include customizations you have made to the
Notes Style.

TheBrain 11 User Guide
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Renaming a Theme

1. Inthe Brain Theme window, click the Theme you want to rename, then
click the Rename button.

2. Type or revise the current name, then click the OK button (or press the

Enter key).
(&>

Themes Colors ( Options
# Mist Covered Mountains ~ O Background, center
# Mystic Lake O Background, top and bottom
# Painted Sky @ Thoughts, text
# Polygon Gray © Thoughts, text shadow
# Relaxed Ocean

2} Rename the Selected Theme X

# To the Woods
Dark Gray \My New Themel I
Dream Logic | OK I I Gancel |
Light Gray W Gares
My New Theme @ Highlighted Gates
Purple Prince @ Active Thought, outline

Figure 77. Renaming a Theme

3. Click the close button to close the Brain Theme window.

Deleting a Theme

1. Inthe Brain Theme window, click the Theme you want to delete, then click
the Delete button.

Clicking on a Theme that you want to rename will activate this Theme in your
[ Brain. You may want to save your current Theme first (if it has been
customized) before renaming another, existing Theme.
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@ Brain Theme

Themes

# Mist Covered Mountains »

# Mystic Lake

ng

YEmironmBmnt a i

# Painted Sky
X
Delete QU Cancel
Light Gray
My New Theme Favorite
Purple Prince v
Figure 78. Deleting a Theme
2. Click the Delete buttont o conf i rm that youdre

Theme.

3. Click the close button to close the Brain Theme window.

Importing and Exporting Themes

@ Brain Theme

Themes

y / Colors \ Options

# 20 Years
# 20 Years-Light

# Brain Animals

# Brain Waves 1
# Brain Waves 2
# Brain Waves 3
# Cold Ocean

# Dark Garden

- Classic Dark Blue
- Light Blue Default

# Brain Animals-Light

O Background, center
O Background, top and bottom
@ Thoughts, text
© Thoughts, text shadow
O Thoughts, background
@ Highlighted Thoughts
@ Links
@ Highlighted Links
® Gates
@ Highlighted Gates

| @ Active Thought, outline

v

==
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Figure 79. Importing or Exporting a Theme
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Customi zing Your Brainds

To import a Theme:

A Click the Import button, navigate to the location of the .BrainTheme file you
want to import, select it, then click the Open button.

To export a Theme:
A Make sure the Theme you want to export is in the active Brain tab.

A Click the Export button, navigate to the location where you want to save the
Theme, then click the Save button.

A Click OK in the confirmation box.

Dark Mode

The Dark Mode changes the windows, menus, icons and other user interface
elements to be predominantly dark grey. Dark Mode allows you to focus on your
work with subtle colors fewer distractions.

9 To switch to Dark Mode, open Preferences to the Look and Feel tab.
Select Dark under the User Interface setting.

1 The Brain will be restarted to apply the change

Figure 80. TheBrain in Dark Mode

1 You may want to modify your Brain Theme to compliment the darker
interface and tones

T On macOS, the Dark Mode setting will follow your OS automatically.
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